FieldPoint™

FP-1000/1001 User Manual

Note to Users

The contents of this document that refer to FieldPoint software are not intended for use with FieldPoint Software 4.0 or LabVIEW 7.0. Refer to the Measurement & Automation Explorer Help for FieldPoint and the FieldPoint LabVIEW Interface Help.
Important Information

Warranty
The FieldPoint FP-1000 and FP-1001 network modules are warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.

In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it. National Instruments makes no warranty of merchantability or fitness for a particular purpose. Customer’s right to recover damages caused by fault or negligence on the part of National Instruments shall be limited to the amount therefore paid by the customer. National Instruments will not be liable for damages resulting from loss of data, profits, use of products, or incidental or consequential damages, even if advised of the possibility thereof. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages resulting from actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

Trademarks
BridgeVIEW™, CVI™, FieldPoint™, LabVIEW™, Lookout™, National Instruments®™, NI™, and ni.com™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help > Patents in your software, the patents.txt file on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREFORER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFERS FROM NATIONAL INSTRUMENTS’ TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
Figures

Figure 1-1. FP-1000 and FP-1001 Network Modules................................. 1-1
Figure 2-1. DIN Rail Clip in the Unlocked Position............................. 2-1
Figure 2-2. Installing the FP-1000/1001 Network Module onto a DIN Rail.... 2-2
Figure 2-3. Locking the FP-1000/1001 Network Module onto a DIN Rail..... 2-2
Figure 2-4. Connecting Terminal Bases.............................................. 2-3
Figure 2-5. FieldPoint Network Module........................................... 2-4
Figure 2-6. Installing the Network Panel Mount Accessory.................. 2-5
Figure 2-7. Module Installation Diagram......................................... 2-6
Figure 2-8. Host Computer Connected to One FP-1000 and Two FP-1001 Network Modules.................................................. 2-7
Figure 2-9. RS-232 Connector Pinout for the FP-1000....................... 2-8
Figure 2-10. Host Computer Connected to Three FP-1001 Network Modules 2-9
Figure 2-11. RS-485 Connector Pinout for the FP-1000 and FP-1001...... 2-10
Figure 2-12. Terminating RS-485 Using the Combicon Adapter........... 2-10
Figure 2-13. Typical Signal Connections for Host Computer Connected to One FP-1000 and Multiple FP-1001 Network Modules...... 2-11
Figure 2-14. Typical Signal Connections for Host Computer Connected to Multiple FP-1001 Network Modules......................... 2-11
Figure 2-15. Address and Baud Rate Switch.................................... 2-12
Figure 2-16. FP-1000/1001 Power Connector Pinout.......................... 2-16
Figure 3-1. LEDs on the FP-1000/1001............................................ 3-7
Figure 4-1. FieldPoint Explorer Window....................................... 4-5
Figure 4-2. ToolTips Showing the Name of an Item........................... 4-6
Figure 4-3. ScreenTips Showing a Description of an Item.................... 4-7
Figure 4-4. Communication Resource Configuration Window.................. 4-8
Figure 4-5. Channel Configuration Dialog Box................................... 4-10
Figure 4-6. Creating the FieldPoint Object...................................... 4-14
Figure 4-7. Modifying the FieldPoint Data Members............................ 4-15
Figure 4-8. LabVIEW Diagram for LabVIEW Example Application......... 4-17
Figure 4-9. Front Panel for LabVIEW Example Application.................. 4-17

Tables

Table 2-1. Network Address Switch Settings for the FP-1000/1001........ 2-14
Table 2-2. Baud Rate Switch Settings for the FP-1000/1001.................. 2-15
Table 3-1. Module Configuration Results After HotPnP Replacement...... 3-6
Table 3-2. STATUS LED Flashes and Corresponding Error Conditions........ 3-8
About This Manual

This manual describes how to install and use the FieldPoint FP-1000 and FP-1001 network modules.

How to Use This Manual Set

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options to a final action. The sequence File » Page Setup » Options directs you to pull down the File menu, select the Page Setup item, and select Options from the last dialog box.

💡 This icon denotes a tip, which alerts you to advisory information.
About This Manual

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash.

**bold**

Bold text denotes items that you must select or click in the software, such as menu items and dialog box options. Bold text also denotes parameter names.

**FP-1000/1001**

Refers to the FP-1000 network module and/or the FP-1001 network module, in cases where the text applies to both modules. Any specific differences are noted.

**italic**

Italic text denotes variables, emphasis, a cross reference, or an introduction to a key concept. This font also denotes text that is a placeholder for a word or value that you must supply.

**monospace**

Text in this font denotes text or characters that you should enter from the keyboard, sections of code, programming examples, and syntax examples. This font is also used for the proper names of disk drives, paths, directories, programs, subprograms, subroutines, device names, functions, operations, variables, filenames and extensions, and code excerpts.

**monospace italic**

Italic text in this font denotes text that is a placeholder for a word or value that you must supply.
FP-1000/1001 Network Module Overview

This chapter provides an overview of the FieldPoint network modules.

Capabilities of the Network Modules

A FieldPoint system consists of at least one network module, at least one terminal base, and one or more I/O modules.

The FP-1000 FieldPoint network module connects an industrial RS-232 network to FieldPoint I/O modules. The FP-1001 FieldPoint network module connects an industrial RS-485 network to FieldPoint I/O modules.

Figure 1-1 shows the FP-1000 and FP-1001 network modules.
The FP-1000/1001 supports standard commands (subset of Optomux command set) and a set of extended commands to completely support the FieldPoint I/O modules. Both network modules can co-exist with other Optomux devices on the same network.

The FP-1000/1001 uses the Optomux protocol. Therefore, after you have configured the FieldPoint bank (network module and I/O modules), you can use any application software that supports Optomux to communicate with FieldPoint modules in the bank.

In a distributed application, many FieldPoint banks are networked together. You can network up to 25 FieldPoint banks to each RS-232/RS-485 port of your host computer. Each bank can contain up to nine I/O modules, thus connecting up to 225 I/O modules per RS-232 (or RS-485) port in your host computer. You can further increase your field I/O count by using more RS-232/RS-485 ports in your host computer.

**FP-1000 Connects to RS-232**

The FP-1000 connects directly to the RS-232 port that is available on most host computers. Because RS-232 is a point-to-point network that allows connection to only one device, the FP-1000 provides an RS-485 repeater so that you can build a network with multiple FieldPoint banks by connecting one or more FP-1001s to a single FP-1000.

**FP-1001 Connects to RS-485**

The FP-1001 FieldPoint network module connects directly to any RS-485 adapter card installed in your host computer, or to the RS-485 repeater port of an FP-1000. Because RS-485 is inherently a multidrop network, the FP-1001 does not provide a separate RS-485 repeater. You can network multiple FP-1001 modules in multidrop fashion.

The FP-1001 communicates over RS-485, utilizing full-duplex mode. It is optically isolated, which prevents fault coupling between the RS-485 network and the FP-1001.
Hardware Installation and Configuration

This chapter describes how to install and configure your FieldPoint FP-1000 or FP-1001 network module, connect it to an RS-232 or RS-485 network, and connect power to the network module.

Mounting the FP-1000/1001 and Terminal Bases

You can choose either of two methods of securely mounting a FieldPoint system: DIN rail mounting or direct panel mounting. Mounting directly to a panel is generally the more secure of the two options, but DIN rail mounting might be more convenient in your application. The following sections give instructions for both mounting methods.

Mounting the FP-1000/1001 on a DIN Rail

The FieldPoint network modules have rugged, simple clips for reliable mounting onto a standard 35 mm DIN rail. Follow these steps to mount the FP-1000/1001 network module onto a DIN rail.

1. Use a flat-bladed screwdriver to open the DIN rail clip to the unlocked position, as shown in Figure 2-1.

![Figure 2-1. DIN Rail Clip in the Unlocked Position](image-url)
2. Hook the lip on the rear of the network module onto the top of a 35 mm DIN rail and press the network module down onto the DIN rail as shown in Figure 2-2.

![Figure 2-2. Installing the FP-1000/1001 Network Module onto a DIN Rail](image)

3. Slide the network module to the desired position on the DIN rail. After the module is in position, push the rail clip into the locked position to lock the module in place on the DIN rail, as shown in Figure 2-3.

![Figure 2-3. Locking the FP-1000/1001 Network Module onto a DIN Rail](image)

After the network module is installed, connect the terminal base to the network module as explained in the next section, Connecting Terminal Bases with DIN Rail Mounting.
Chapter 2  Hardware Installation and Configuration

Connecting Terminal Bases with DIN Rail Mounting

Follow these steps to connect a terminal base to an FP-1000/1001 network module when you are using DIN rail mounting.

**Note**  Ensure that power is not applied to the network module before you install or remove terminal bases.

1. Remove the protective cover from the network module’s local bus connector (see Figure 2-2) or from the bag of accessories that came with your network module.
2. Install the terminal base onto the DIN rail in the same way you installed the network module.
3. Attach the terminal base to the network module by firmly mating the local bus connectors.
4. To add more terminal bases, install them on the rail and connect their local bus connectors together.
5. Place the protective cover onto the last terminal base on the bank, as shown in Figure 2-4.

**Figure 2-4. Connecting Terminal Bases**

Removing the FP-1000/1001 from the DIN Rail

To remove an FP-1000/1001 network module, unlock it from the DIN rail by placing a screwdriver in the slot on the rail clip and opening it to the unlocked position as shown in Figure 2-1.

Then, disconnect the module from the local bus connector of the terminal base, and lift the module off of the rail.
Mounting the FP-1000/1001 to a Panel

Perform the following steps to install the optional FieldPoint network panel mount accessory and mount the FP-1000/1001 network module. You can order the panel mount accessory, part number 777609-01, from National Instruments.

1. Make sure that the rail clip on the network module is unlocked. Figure 2-5 shows a FieldPoint network module and the locked and unlocked positions of the rail clip.

![Figure 2-5. FieldPoint Network Module](image)

2. Snap the panel mount accessory onto the module as shown in Figure 2-6.
3. Press on the rail clip to lock it. The locked position is shown in Figure 2-5.

4. Mount the network module with the panel mount accessory. The installation guide that came with the panel mount accessory includes a guide you can use to drill pilot holes for mounting the module.

**Connecting Terminal Bases with Panel Mounting**

The terminal bases can be directly installed without using the panel mount accessory that is needed for mounting the FP-1000/1001 network module. Follow these steps to connect terminal bases to a network module when you are using panel mounting.

**Note**  Ensure that power is not applied to the network module before you install or remove terminal bases.

1. Remove the protective cover from the network module’s local bus connector (see Figure 2-5).
2. Drill pilot holes in the panel to mount the terminal bases. A drilling guide is provided with the network module panel mount accessory.
3. Attach the terminal base to the network module by firmly mating the local bus connectors.
4. Bolt, screw, or otherwise fasten the terminal base to the panel. Ensure that the local bus connectors remain firmly mated after the terminal base is mounted.
5. To add more terminal bases, repeat Steps 2 through 4, mating the local bus connectors of each new terminal base to the connector of the last installed base. If all the pilot holes were correctly drilled, the local bus connectors should all remain firmly mated after all the bases are mounted to the panel.

6. Place the protective cover that you removed from the network module in Step 1 onto the local bus connector of the last terminal base on the bank.

**Removing the FP-1000/1001 and Terminal Bases from the Panel**

To remove the FP-1000/1001 network module and terminal bases from the panel, reverse the process described in the previous sections, *Mounting the FP-1000/1001 to a Panel* and *Connecting Terminal Bases with Panel Mounting*. First remove the terminal bases, starting with the last one, then remove the network module.

**Installing I/O Modules onto Terminal Bases**

To connect an I/O module, install it onto a terminal base. Refer to Figure 2-7 and follow these steps:

1. Position the first module with its alignment slots aligned with the guide rails on the terminal base.
2. Press firmly to seat the module on the terminal base. The terminal base latch locks the I/O module into place when the module is firmly seated.
3. To connect additional I/O modules, repeat the procedure to install them onto additional terminal bases.

![Figure 2-7. Module Installation Diagram](image-url)
Connecting the FP-1000 to Your Computer

This section describes the network configurations possible with the FP-1000 network module.

Connect the RS-232 port of the FP-1000 to your host computer’s RS-232 port. Use a 9-pin DSUB male-to-female straight-through cable. Do not use a null modem cable (usually female-to-female).

You can connect only one FP-1000 for each RS-232 port in your host computer. You can add more FieldPoint banks without using more RS-232 ports of your host computer, by connecting one or more (up to 24) FP-1001 network modules to the RS-485 repeater port of the FP-1000. This network configuration is shown in Figure 2-8.

![Figure 2-8. Host Computer Connected to One FP-1000 and Two FP-1001 Network Modules](image)

The RS-485 repeater port on the FP-1000 must always be wired in 4-wire, full-duplex mode.

**RS-232 Interface Specifications**

RS-232 specifies a maximum cabling distance of 50 ft, but improvements in line drivers and cabling technology often allow you to design your network beyond the recommendations of the specification.
The RS-232 connector is 9-pin female DSUB connector whose pinout is shown in Figure 2-9.

![RS-232 Connector Pinout for the FP-1000](image)

Figure 2-9. RS-232 Connector Pinout for the FP-1000

The FP-1000 does not use RS-232 hardware handshaking, but it still asserts the RTS and DSR signals for host computers or software that might require these signals. A host computer that does not use these signals does not need to connect to them.

Connecting the FP-1001 to the Serial Network

This section describes the network configurations possible with the FP-1001 FieldPoint network module.

One option for connecting the FP-1001 is to connect it to the RS-485 repeater port of an FP-1000 as shown in Figure 2-8. The RS-485 port on the FP-1001 must be wired in 4-wire, full duplex mode when connected to the RS-485 repeater port.

An alternative method is to connect the FP-1001 directly to your host computer, if your host computer provides an RS-485 interface. Contact National Instruments for information about available RS-485 hardware. You can connect up to 25 FP-1001 network modules to each RS-485 port on the host computer. This network configuration method is shown in Figure 2-10.
When the FP-1001 is cabled directly to an RS-485 port on a host computer, as shown in Figure 2-10, you can wire it in either 4-wire full duplex mode or 2-wire half duplex mode.

The multidrop topology used by the RS-485 network in these two networking configurations protects against power failures at individual FieldPoint banks. It eliminates the possibility that a power failure at one FP-1001 bank might affect the communication between other banks in your network. Because the FP-1000 provides an RS-485 repeater, a power failure at that bank affects communications.

Caution  Do not use the isolation barrier of the RS-485 interface as a way to protect human contact from common-mode voltages of more than 250 Vrms. The RS-485 interface on both the FP-1000 and the FP-1001 modules is isolated from the rest of the FieldPoint system, including the power supply, backplane, and the RS-232 interface on the FP-1000. It is isolated with a galvanic and optical isolation barrier, which has been designed and tested to withstand fault voltages of up to 2500 Vrms. However, the safety rating of this barrier is only for working voltages of up to 250 Vrms. Also, notice that while the RS-232 interface on the FP-1000 is isolated from the RS-485 interface, it is NOT isolated from the power supply inputs (the V and C terminals).

RS-485 Interface Specifications

RS-485 specifies a maximum cabling distance of 4,000 ft, but improvements in line drivers and cabling technology often allow you to design your network beyond the recommendations of the specification. If even longer distances are desirable, you can use RS-485 repeaters.
An RS-485 stub is created when you tap the RS-485 backbone to form a T-junction. RS-485 stubs must be less than 3 in. long. However, you can create longer stubs by using an RS-485 repeater to start the stub, ensuring that the repeater is close to the junction.

The RS-485 connector is a 5-pin Combicon connector whose pinout is shown in Figure 2-11.

**Figure 2-11.** RS-485 Connector Pinout for the FP-1000 and FP-1001

### RS-485 Network Termination and Biasing

An RS-485 network must be terminated at each end of the network, but not anywhere else. At each end bank, termination resistors should be installed between the RX pair and between the TX pair. These network terminating resistors are nominally 120 Ω and are provided in your kit. To install them, twist the resistor leads with the RS-485 signal wires and then insert them into the RS-485 Combicon adapter as shown in Figure 2-12. The 120 Ω resistor in the figure is a terminating resistor.

**Figure 2-12.** Terminating RS-485 Using the Combicon Adapter

An RS-485 network also needs biasing resistors to protect the devices on the network against noise during intervals when no RS-485 drivers are transmitting on the network. The host computer’s RS-485 interface normally has provision for such biasing resistors. When you are using FP-1001 network modules directly connected to a host computer’s RS-485 interface, use the biasing feature of the host computer’s RS-485 interface for better reliability and noise immunity. The RS-485 repeater interface on
the FP-1000 already has biasing resistors, so you do not need to do anything when connecting one or more FP-1001 modules to the FP-1000.

Figures 2-13 and 2-14 show typical RS-232 and RS-485 signal connections and termination for a FieldPoint network. Figure 2-13 is a more detailed depiction of Figure 2-8, and Figure 2-14 is a more detailed depiction of Figure 2-10.

**Figure 2-13.** Typical Signal Connections for Host Computer Connected to One FP-1000 and Multiple FP-1001 Network Modules

**Figure 2-14.** Typical Signal Connections for Host Computer Connected to Multiple FP-1001 Network Modules
Configuring the FP-1000/1001

Figure 2-15 shows the 8-position switch on the FP-1000/1001 network module. Switches 1–5 set the network address, and switches 6–8 set the baud rate.

The FP-1000/1001 is preconfigured for network address 0 and a baud rate of 115.2 kbps. If you are connecting only a single network module, you do not need to change the network address from the preconfigured setting of address 0. You should not need to change the baud rate setting unless you are experiencing communication problems.

Follow these steps if you need to change the address and baud rate for your FP-1000/1001 network module.

1. Choose and set a network address. Refer to the following section, Setting the Network Address, for more information.

2. Choose and set the baud rate. For more information, refer to the Setting the Baud Rate section, later in this chapter.

3. Write your address and baud rate settings in the space provided on the FP-1000/1001 label.

4. Apply (or cycle) power to the bank, to enable the FP-1000/1001 for the new network address and baud rate.

5. Make the same address and baud rate changes in your FieldPoint software. Refer to Step 4 in the Getting Started with FieldPoint Explorer section of Chapter 4, Installing and Using the FieldPoint Software, for more information.
Setting the Network Address

**Note** If you are connecting only a single FP-1000/1001 network module, you do not need to change the network address from the preconfigured setting of address 0. If you are connecting more than one network module to the same host computer port, ensure that each network module has a unique address.

Switches 1–5 set the network module address. The addresses of the terminal bases in a FieldPoint bank are automatically configured by the network module to be sequentially higher than the network module’s address. For example, if the network module is set to address 20, the I/O module in the terminal base adjacent to the network module is at address 21, the next I/O module is at address 22, and so on. A terminal base is assigned an address whether an I/O module is inserted on it or not. The network module’s address is determined by the settings of the switches when the modules is powered on. If the switch settings are changed while the module is powered, the module must be powered off then on again before the new settings are applied.

Table 2-1 shows the possible switch positions and the corresponding address of the FieldPoint network module.
### Table 2-1. Network Address Switch Settings for the FP-1000/1001

<table>
<thead>
<tr>
<th>Switch Positions 1–5</th>
<th>Network Module Address (Decimal)</th>
<th>Switch Positions 1–5</th>
<th>Network Module Address (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td></td>
<td>130</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td></td>
<td>140</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td></td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td></td>
<td>160</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td></td>
<td>170</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td></td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>60</td>
<td></td>
<td>190</td>
</tr>
<tr>
<td></td>
<td>70</td>
<td></td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>80</td>
<td></td>
<td>210</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td></td>
<td>220</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td></td>
<td>230</td>
</tr>
<tr>
<td></td>
<td>110</td>
<td></td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>Other Settings</td>
<td>Not Allowed</td>
</tr>
</tbody>
</table>
Setting the Baud Rate

Switches 6–8 set the network module baud rate. Table 2-2 shows the switch positions and the corresponding network baud rates of the FP-1000/1001 network module. The network module’s baud rate is determined by the settings of the switches when the module is powered on. If the switch settings are changed while the module is powered, the module must be powered off then on again before the new settings are applied.

Note The preconfigured setting of 115.2 kbps should provide the fastest performance, and you should not need to change this setting unless you are experiencing communication problems. If you are connecting more than one network module to the same host computer port, ensure that every network module’s baud rate setting is identical.

The serial interface on the FP-1000/1001 always uses the following parameters: 1 start bit, 8 data bits, 1 stop bit, and no parity.

Table 2-2. Baud Rate Switch Settings for the FP-1000/1001

<table>
<thead>
<tr>
<th>Switch Positions 6–8</th>
<th>Network Module Baud Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>300</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>1200</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>2400</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>9600</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>19200</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>38400</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>57600</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>115200</td>
</tr>
</tbody>
</table>

Connecting Power to the FP-1000/1001

An 11–30 VDC power supply is required by each FieldPoint network module. The network module filters and regulates this supplied power and provides power for all the I/O modules in the bank. Therefore you need not provide power separately to each FieldPoint I/O module in the bank.

The power connector is a 4-pin screw terminal connector whose pinout is shown in Figure 2-16.
The two terminals labeled V are internally connected on the network module, as are the two terminals labeled C. Power must be applied to one V and C pair for operation of the FieldPoint bank. If you want to power your field I/O devices from the same power supply, the second V and C pair provides a convenient means of connecting power to the V and C terminals of a terminal base. Figure 2-16 shows this optional connection.

If your field I/O devices need to be powered separately, you can use the terminals provided on each terminal base for such power supply connections. Refer to the documentation that came with your terminal base and I/O module for more information on powering your field I/O devices.

### Calculating Power for a FieldPoint Bank

The power requirements for a FieldPoint bank that uses an FP-1000/1001 network module are calculated as follows:

\[
\text{Power} = 1 \text{ watt} + 1.55 \times \Sigma (I/O \text{ Module Consumption})
\]

This is the amount of power the network module consumes from the power supply to power itself and the I/O modules. It does not include any power consumed by devices that you wire to the terminal bases.

The operating instructions for each FieldPoint I/O module contain power consumption information.

### Completed Hardware Installation

When power is applied, the ACCESS and STATUS LEDs should flash once, and the POWER LED should stay lit. The POWER and READY LEDs should be lit on all of the I/O modules. If these LEDs are not lit, check your power connections and make sure that all of your modules and terminal bases are firmly mated. If the STATUS LED is blinking, refer to Table 3-2, STATUS LED Flashes and Corresponding Error Conditions, in Chapter 3, Feature Set Description.
Feature Set Description

This chapter describes the feature set for the FP-1000 and FP-1001 network modules.

High-Speed Local Bus

The FP-1000/1001 provides a high-speed local bus for communication to the I/O modules in the bank. The high-speed local bus has low overhead that enables fast response to commands from the host computer.

Network Watchdog Timer

The FP-1000/1001 can detect unexpected periods of network inactivity and respond to them in a user-defined way. The network watchdog timer feature enables you to guard your system against failures in the network connection, cables, or host computer, and to put the channel outputs in a user-defined state (the watchdog state) if such failures do occur.

You can set the watchdog output values to be different from the power-up output values. Some system applications do not differentiate between power-up output values and watchdog output values, while other applications treat the two conditions differently. The FP-1000/1001 supports both types of applications.

By default, the watchdog timer for the bank is disabled on power up. To use the watchdog timer, set up the following parameters. You can use either the FieldPoint Explorer software or the FieldPoint command set.

- Watchdog data value for each channel
- Watchdog data enable/disable status for each channel
- Watchdog enabled/disabled status for each I/O module
- Watchdog timeout value for the bank

Note Each bank has only one watchdog timeout value that is common for all the modules in that bank. In addition, the current watchdog timeout value is not stored when you store the SnapShot.
SnapShot Feature

Many applications require that, upon startup, the system’s I/O modules power up with user-specified configuration and output levels rather than factory default settings. The SnapShot feature provides you with a single-step method to store the current state of your FieldPoint bank for use as the power-up state of the bank.

If you subsequently enable the SnapShot feature, you can ensure that your system powers up with the configuration and output levels that you specified when storing the SnapShot.

Prior to storing the SnapShot, bring all the channels to the desired power-up settings. You can use either the FieldPoint Server software or the FieldPoint command set to change the configuration of the FieldPoint bank, and then store the SnapShot. The SnapShot stores all the following information in a single step:

- Attribute and range settings of each channel.
- Output values of each channel.
- Watchdog data values of each channel. See the Network Watchdog Timer section in this chapter for more information.
- Watchdog data enabled (or disabled) status for each channel. See the Network Watchdog Timer section in this chapter for more information.
- Watchdog enabled (or disabled) status of each module. See the Network Watchdog Timer section in this chapter for more information.

After you store the SnapShot information, you can still choose whether the FP-1000/1001 uses that stored information during future power-ups. Enable the SnapShot feature if you want the FieldPoint bank to power up with the stored SnapShot information.

If you have enabled the SnapShot feature, the FP-1000/1001 restores the stored settings to all I/O modules and channels in the bank every time you power up, until you disable the SnapShot feature. If the SnapShot feature is disabled, the FieldPoint bank powers up with factory-default settings.

At some time you might want to change the stored SnapShot information. To make incremental changes in the stored SnapShot information, you can use the features described in the next section, Programmable Power-Up State.

Note The current watchdog timeout value for the FieldPoint bank is not saved when you store the SnapShot.
The SnapShot feature inherently requires that the entire FieldPoint bank be at your desired power-up state, since when you store the SnapShot information, the current settings of the entire bank are stored for use at future power-ups.

### Programmable Power-Up State

The SnapShot feature described in the SnapShot section provides you with a single-step method to store the current state of the FieldPoint bank for use as the power-up state. The FP-1000/1001 provides an alternative method to define power-up states that allows you to store the SnapShot information with more flexibility, as described in this section.

The Programmable Power-Up State feature enables you to define the power-up configuration on a module-by-module basis. In addition, you do not need to actually set any of the channels to the desired power-up state. You can therefore define the power-up states regardless of the current settings of any channel of a module.

Optionally, you can utilize the Programmable Power-Up State feature to incrementally modify previously stored SnapShot information.

If you subsequently enable the SnapShot feature, you can ensure that your system powers up with the configuration and output levels that you specified when storing the Programmable Power-Up States.

You can use the Programmable Power-Up State feature to individually store the following information. You can use either the FieldPoint Explorer software or the FieldPoint command set.

- Attribute and range settings of each channel
- Output values of each channel
- Watchdog data value of each channel. See the Network Watchdog section in this chapter for more information.
- Watchdog data enabled (or disabled) status for each channel. See the Network Watchdog section in this chapter for more information.
- Watchdog timer enabled (or disabled) status of each module. See the Network Watchdog section in this chapter for more information.
- Power-up watchdog timeout value for the FieldPoint bank
- The turn-around delay for each module
- The hot-swap reporting mode for the FieldPoint stack. See the next section, HotPnP (Hot Plug and Play), for more information on the hot-swap reporting mode.
If you have enabled the SnapShot feature, the FP-1000/1001 restores your desired settings to all I/O modules and channels in the bank every time you power up, until you disable the SnapShot feature.

**HotPnP (Hot Plug and Play)**

The HotPnP feature simplifies system installation, configuration, and maintenance. With the HotPnP feature, you can remove or insert I/O modules into the FieldPoint terminal bases while power is on, even if the system is already engaged in network activity. You do not need to power down the entire system or even a bank to insert, remove, or replace I/O modules. In addition, you do not need to change the operation of the host computer or software to use the HotPnP feature.

When you insert an I/O module with the power on, it is automatically recognized, configured, and made available on the network. The following sections describe how the HotPnP feature works under different conditions.

**Note**  Do not add or remove terminal bases while power is applied to the bank. An I/O module can be hot-inserted only if an empty terminal base is already available in the bank.

**HotPnP During Power-Up**

Upon power-up, the FP-1000/1001 automatically uploads an electronic data sheet (EDS) from each I/O module in its bank. The FP-1000/1001 then configures each I/O module in the bank to factory default settings in the module’s EDS, or stored SnapShot settings if the SnapShot feature is enabled.

**HotPnP During Operation**

You might need to insert or replace one or more I/O modules in a bank while your system is operational (power is on and the network may or may not be active).

**Inserting New I/O Modules**

When a new I/O module is inserted, the FP-1000/1001 automatically uploads the EDS and configures the I/O module to factory default settings in the module’s EDS, or to stored SnapShot settings if the SnapShot feature is enabled. This configuration is accomplished without any intervention from the host computer or software.
While one or more new I/O modules in a bank are being serviced by the HotPnP feature, the other I/O modules in the bank remain fully operational and accessible on the network without any interruptions. As soon as the FP-1000/1001 configures the new I/O module via the HotPnP service, that I/O module becomes automatically accessible on the network.

Replacing I/O Modules

When an I/O module is removed, the FP-1000/1001 does not undertake any special course of action for the bank. The host computer (or the software executing on it) might be unaware that the I/O module is missing, and could continue to send commands to the missing I/O module. Each command returns an error response, but the FP-1000/1001 remembers the commands sent to the missing I/O module.

When a new I/O module is connected in place of the one that was removed, the FP-1000/1001 first verifies that the replacement I/O module is compatible with the one that was removed. If the I/O module is the same as, or is compatible with, the one removed, the FP-1000/1001 configures the replacement I/O module with its predecessor’s configuration and output value settings. It also applies the effects of any commands sent by the host computer while the I/O module was missing.

If the replacement module is incompatible with the one that was removed, the FP-1000/1001 looks at the information stored in the SnapShot. If the SnapShot is enabled and the replacement module is compatible with the information in the SnapShot, the FP-1000/1001 configures the replacement module with the SnapShot configuration. Otherwise, the FP-1000/1001 configures the replacement module to factory default settings.

Table 3-1 shows how modules are configured after HotPnP replacement.
While one or more replacement I/O modules in the bank are being serviced by the HotPnP feature, the other I/O modules in the bank remain fully operational and accessible on the network without any interruptions. As soon as the FP-1000/1001 configures a replacement I/O module via the HotPnP service, that I/O module becomes automatically accessible on the network.

### Table 3-1. Module Configuration Results After HotPnP Replacement

<table>
<thead>
<tr>
<th>SnapShot Feature</th>
<th>Replacement Module</th>
<th>Replacement Module Configuration After HotPnP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled/Disabled</td>
<td>Compatible with the removed module</td>
<td>Same as the configuration of the removed module</td>
</tr>
<tr>
<td>Disabled</td>
<td>Incompatible with the removed module</td>
<td>Factory default configuration of replacement module</td>
</tr>
<tr>
<td>Enabled</td>
<td>Incompatible with the removed module but compatible with the SnapShot information</td>
<td>Same as the configuration stored in the SnapShot</td>
</tr>
<tr>
<td>Enabled/Disabled</td>
<td>Incompatible with the removed module and incompatible with the stored SnapShot information</td>
<td>Factory default configuration of replacement module</td>
</tr>
</tbody>
</table>

Power-On Self Test (POST)

The power-on self test (POST) is a test suite that the FP-1000/1001 performs at power up to verify its own operational status. The test is non-invasive and therefore does not affect the operation of the network, nor does it affect any of your field wiring connected to the terminal bases in the bank.

If the self-test suite fails, the FP-1000/1001 does not participate in the network communication traffic, thereby eliminating potential conflicts with the other banks in your network.

The FP-1000/1001 indicates POST failure via the STATUS LED. Refer to the next section, LED Indicators, for more information.
LED Indicators

The FP-1000/1001 has four LED indicators: POWER, NETWORK, ACCESS, and STATUS. Figure 3-1 shows the LEDs on the FP-1000/1001.

The green POWER LED is lit while the FP-1000/1001 is powered up. This LED indicates that the power supply connected to the FP-1000/1001 is acceptable, and that the FP-1000/1001 is supplying power to the I/O modules.

The yellow NETWORK LED is lit during transmissions from the host computer on the network. This LED indicates that the FP-1000/1001 is receiving from the network, and that the communication wires to it are not broken. The NETWORK LED gets brighter as activity on the network increases.

The yellow ACCESS LED flashes when the FP-1000/1001 or any of the I/O modules in its bank respond to the host computer. This LED indicates that a module in the bank was addressed by a correctly formatted command, and that the module is responding to that command (either with a success or error response).
The red STATUS LED is lit when the FP-1000/1001 detects a failure. If STATUS is not lit, the FP-1000/1001 has not detected a failure. The FP-1000/1001 indicates specific error conditions by flashing STATUS a specific number of times. Table 3-2 describes the STATUS LED flashing sequences and the corresponding error condition.

Table 3-2. STATUS LED Flashes and Corresponding Error Conditions

<table>
<thead>
<tr>
<th>Number of Flashes</th>
<th>Error Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (stays lit)</td>
<td>The FP-1000/1001 initialization failed.</td>
</tr>
<tr>
<td>1</td>
<td>The FP-1000/1001 address switch is incorrectly configured. Refer to the Setting the Network Address section in Chapter 2, Hardware Installation and Configuration.</td>
</tr>
<tr>
<td>2</td>
<td>The FP-1000/1001 has detected an error in the terminal bases in the bank or has identified a module in an illegal state. Verify that the protective cover is on the local bus connector of the last terminal base and that none of the pins of that connector are touching or bent.</td>
</tr>
<tr>
<td>3</td>
<td>The FP-1000/1001 has detected an irrecoverable internal error with its firmware.</td>
</tr>
<tr>
<td>5</td>
<td>The network module was unable to locate an I/O module waiting to be configured. Verify that there are no more than nine terminal bases in the bank, and that no terminal bases were added to the bank while power was applied.</td>
</tr>
</tbody>
</table>
Installing and Using the FieldPoint Software

This chapter describes how to use the FieldPoint hardware with various servers and software packages.

FieldPoint Software Overview

Your FieldPoint software includes a full-functioned configuration utility as well as server and driver software for easy integration into application software packages. These software components manage the low-level communications and hardware details, simplifying programmatic access of I/O channels. Version 1.6 of the FieldPoint software runs on Windows NT 4.0 and later, Windows 98, and Windows 95, and includes the following components:

- FieldPoint Explorer Configuration Utility
- Lookout Driver Class
- BridgeVIEW Server
- LabVIEW VIs
- LabWindows/CVI Functions
- OPC Server

You can download future versions of FieldPoint software from the National Instruments FTP site at ftp.natinst.com/support/fieldpoint/Server.

FieldPoint Explorer Configuration Utility

FieldPoint Explorer is the configuration utility for FieldPoint hardware and software. You can use FieldPoint Explorer to accomplish the following tasks:

- Configure the characteristics and hardware of a FieldPoint device network
- Configure the tag name space and I/O items of the FieldPoint servers
- Write and read I/O values to and from the FieldPoint hardware
For more information on FieldPoint Explorer, refer to the Using FieldPoint Explorer section, later in this chapter.

**BridgeVIEW Server**

The BridgeVIEW server for FieldPoint provides communication between FieldPoint devices and applications you develop using the BridgeVIEW graphical programming package for automation. This native BridgeVIEW server allows access to I/O items defined in the FieldPoint Explorer. If you prefer, you can also choose to use the OPC server to access FieldPoint hardware from BridgeVIEW.

For more information on the BridgeVIEW server, refer to the Using the FieldPoint BridgeVIEW Server section, later in this chapter.

**Lookout Driver Class**

The FieldPoint Lookout driver class allows the Lookout object-based automation software package to communicate with the FieldPoint devices. This driver class provides a FieldPoint object with connections to the tag name space of the I/O items configured in the FieldPoint Explorer.

For more information on the Lookout driver class, refer to the Using the FieldPoint Lookout Driver Class section, later in this chapter.

**LabVIEW VIs**

A set of VIs (Virtual Instruments) provide communication between I/O items configured in the FieldPoint Explorer and applications you develop using the LabVIEW graphical programming environment. A set of example applications using these VIs is also provided.

For more information on LabVIEW VIs, refer to the Using the FieldPoint LabVIEW VIs section, later in this chapter.

**LabWindows/CVI Functions**

Applications you develop using the LabWindows/CVI C programming environment use a set of C function calls to communicate with I/O items configured in the FieldPoint Explorer. An instrument driver with a set of function panels and example programs is provided to accelerate your development process.

For more information on LabWindows/CVI functions, refer to the Using the FieldPoint LabWindows/CVI Functions section, later in this chapter.
OPC Server

OPC (Object Linking and Embedding for Process Control) is an industry standard interface that uses Microsoft’s Component Object Model (COM). The FieldPoint OPC server provides an interface to the I/O items configured in the FieldPoint Explorer and software packages that are capable of using OPC, including recent versions of Microsoft’s Visual Basic and Visual C/C++ programming environments, and other third-party software packages.

For more information on the FieldPoint OPC Server, refer to the *Using the FieldPoint OPC Server* section, later in this chapter.

Other Options for Communicating with FieldPoint Devices

It is also possible to communicate with the FieldPoint system using an Optomux-compatible server, or by sending ASCII commands directly to and from the serial port of the host computer. Examples of cases where one of these methods might be useful include the following:

- Communicating with FieldPoint from a computer running an operating system other than Windows NT/98/95
- Communicating with FieldPoint from a device such as a PLC; to integrate FieldPoint devices into an existing Optomux-based system
- Using a programming environment that does not support the OPC interface

If you choose one of these communication methods, refer to the *FP-1000/1001 Programmer Reference Manual* for details on the protocol used by the FieldPoint network modules. You can, however, still use the FieldPoint Explorer to configure the FieldPoint devices before running your software.

For more information on using FieldPoint with Optomux servers, refer to the *Using FieldPoint with an Optomux Server* section, later in this chapter.

Data Throughput with the FieldPoint Servers

The rate at which data can be transferred between a FieldPoint bank and a computer is determined by the number and type of I/O channels and the baud rate. You can download a calculator to determine the data throughput from [ftp.natinst.com/support/FieldPoint/server](ftp.natinst.com/support/FieldPoint/server). This calculator is available as both an Excel Spreadsheet and as a LabVIEW/BridgeVIEW VI.
Chapter 4 Installing and Using the FieldPoint Software

Installing FieldPoint Software

Follow these steps to install your FieldPoint software:

1. If you are using BridgeVIEW, LabVIEW, Lookout, or LabWindows/CVI with FieldPoint, install these other application programs before installing your FieldPoint software. The FieldPoint software installation installs the BridgeVIEW server, LabVIEW VIs and examples, Lookout driver class, and LabWindows/CVI instrument driver only if it finds the corresponding application software installed.

2. Insert the FieldPoint Configuration and Server Software disk number 1 into the floppy drive on your computer.

3. Click on the Windows Start button, and then click on Run.

4. Enter a:\setup, where a is the letter of your floppy drive, then select OK.

5. Follow the onscreen instructions to complete the installation.

Note Do not worry if the installation program does not ask you to insert all of the disks. Depending on the software already installed on your computer, you might not need to use all of the disks that you received.

Using FieldPoint Explorer

The FieldPoint Explorer is the configuration software for FieldPoint hardware and software. The first step to using FieldPoint software is to run the FieldPoint Explorer. You then use FieldPoint Explorer to configure the programmable settings of the FieldPoint hardware, such as the input range of an analog input module, or watchdog timer settings, or the power-up values of output modules. From FieldPoint Explorer you define I/O items (which represent one or more physical I/O channels) that you want to write to or read from. FieldPoint Explorer also provides a user interface from which you can interactively read and write values of these I/O items to verify that your FieldPoint system has been correctly installed and configured.
Figure 4-1 shows the parts of the FieldPoint Explorer window.

Figure 4-1. FieldPoint Explorer Window
Getting Assistance While You Work

FieldPoint Explorer includes several features to help answer your questions about using the software and to reduce the time you spend learning how to use and get the most out of FieldPoint Explorer. These features include ToolTips, ScreenTips, and online help.

ToolTips identify tool bar icons and most items on the screen. Rest your pointer over the element you are interested in, and its name appears, as shown in Figure 4-2.

ScreenTips provide descriptions of the items in a dialog box to help explain what the item does or how you should use it. Display ScreenTips by clicking on the question mark button in the title bar of the dialog box and then clicking on the item you want to know more about. The ScreenTip appears as shown in Figure 4-3.
Getting Started with FieldPoint Explorer

This section guides you through an example of how to configure a FieldPoint system. The online help provides more details and explains all of the features of FieldPoint Explorer.

To get started with FieldPoint Explorer, follow these steps:

1. Install the hardware as described in Chapter 2, Hardware Installation and Configuration. Verify that the FieldPoint system is powered on and the I/O modules have their READY LEDs lit.

2. From the Windows Start menu, select Programs»FieldPoint»FieldPoint Explorer to launch the FieldPoint Explorer program.

3. Add a communications resource to the Device Network Hierarchy. To add the resource, first click on the + sign next to IA Server with OPC in the DNH window to expand the view. Then right-click on the word...
FieldPoint and select **Add a comm resource to this server**. The communications resource dialog box appears as shown in Figure 4-4.

![Communication Resource Configuration Window](image)

**Figure 4-4.** Communication Resource Configuration Window

4. Select the COM port on your computer to which you cabled the FieldPoint system.

The FP-1000/1001 network module is preconfigured for a baud rate of 115200 kbps, so you should not have to change the baud rate or timeout setting in the dialog box unless you have modified the baud rate switches on the network module. The default name for the COM port you select is **FP Res**.

5. Click on the **Find Devices** button to start searching for all of the FieldPoint Devices on this communications resource. If no devices are found, make sure that the FieldPoint hardware is powered on, that the switch settings for the baud rate match the settings on the network module, and that no two network modules on the same communications port have the same address switch settings. Also make sure that you have selected the COM port to which you have connected the FieldPoint system. If FieldPoint Explorer reports that it cannot bind the COM port, make sure that you have selected a COM port that is properly configured in your computer and is not being used by any other program.
6. After the FieldPoint modules are found, click on the + sign next to **FP Res** in the DNH window to expand the device hierarchy and display the modules found on the network.

The hierarchy should include all of the modules you had connected to the communications port. Figure 4-1 shows an example of an expanded device hierarchy. The default name of each device found includes the model number of the FieldPoint module, followed by the @ sign, then the address of the module—for example, “FP-1000 @0”. For each I/O module found, one I/O Item is created for each channel of the module, and one I/O Item is created to represent all of the channels on that module collectively.

7. To configure the hardware settings of a particular I/O module, select the device in the DNH window.

   a. Right-click on the device name and select **Edit the device** from the pop-up menu.
   
   b. Click on the **Channel Configuration** button to bring up the channel configuration dialog box shown in Figure 4-5. In this example, an FP-TC-120 thermocouple module was selected to configure.
   
   c. To configure a channel, select the channel in the Channel Number list. If you clear the **One channel at a time** checkbox, you can select and configure multiple channels at a time.
   
   d. Select the data range for this channel from the **Range** list, as shown in Figure 4-5.
   
   e. Set the attributes of this channel from the **Attribute** list by selecting the desired Attribute Value from the list.
   
   f. If you want to change attributes of a channel from your application, you can do so by creating data items to represent the attributes of the channel. To do this, select the attribute from the **Attribute** list and click on the **Create Item** button.
   
   g. Continue this for each channel that you want to configure.
   
   h. Click on the **OK** button when you are finished.
   
   i. Click on the **Yes** button when asked if you want to write these settings to the device.
8. You can now try to read from the FieldPoint devices that you have configured. Select one of the devices in the DNH window, and then click on the **Start Monitoring** button (green arrow icon) in the Tool Bar to start monitoring the items of that device.

   The tag symbols of the items in the list view window turn blue to show that they are being monitored. The **Value** column in the list view window should show the current value of the I/O channels defined by the I/O Items, and the **Status** column shows any error conditions received while communicating with the FieldPoint network.

9. Click on the **Stop Monitoring** button (red square icon) in the toolbar to stop monitoring the items.

10. You can also write to output channels of I/O Items that you have configured.
   a. Select a device in the DNH window with output channels.
   b. Select the I/O Item in the list view window corresponding to the channel you want to write to.
c. Click on the **Write Value** button (pen and paper icon) in the toolbar to write to the I/O channel(s) represented by the I/O Item.

d. Enter the value you want to write in the **Value** box and click on the **Write Button** to write the value out. The value must be in the range of the channel that you configured in Step 7. For example, if the channel was configured for a range of 0.0035 A to 0.021 A, and you want to write a value of 0.010 A (10 mA), enter 0.010 in the **Value** box. For discrete I/O channels with a Boolean range, enter a 1 or a 0 in the **Value** box.

11. When you are satisfied with the hardware configuration of your FieldPoint system, you can save this configuration as the new power-up state for the hardware.

a. Edit the device configuration of the FP-1000/1001 network module by right-clicking on the network module entry in the DNH window.

b. Select **Edit this device** from the pop-up menu.

c. Make sure that the **factory configuration** checkbox is not checked.

d. If you only want the range and attribute settings you configured in Step 7 to be saved as power-up states, you can just click on the **OK** button, because these settings get written to the non-volatile memory of the network module when you write changes to the device in Step 7.

e. If you also want to save all of the current output states of the output channels, click on the **Snapshot** button to store all of the output values of that bank of FieldPoint modules to the power-up memory of the network module, then click on the **OK** button when you are finished.

12. When you are finished configuring the hardware settings and the I/O items, you must save your configuration file. Select **File»Save** from the menu bar.

13. Exit the FieldPoint Explorer application.

---

**Note** You must exit FieldPoint Explorer before you can communicate with the FieldPoint system using one of the methods described in the subsequent sections.
Using the FieldPoint BridgeVIEW Server

The FieldPoint BridgeVIEW server is a device server based on the native BridgeVIEW server architecture. The I/O items you configured in the FieldPoint Explorer become available to the BridgeVIEW server when you export the configuration data from FieldPoint Explorer into the BridgeVIEW common configuration database (CCDB). From within BridgeVIEW, the Tag Configuration Wizard imports this configuration information, creating a tag for every I/O item you configured in the FieldPoint Explorer. These tags are immediately accessible through the BridgeVIEW real-time database.

To start using the FieldPoint server with BridgeVIEW, follow these steps:

1. Configure and test your FieldPoint server from FieldPoint Explorer, as described in the Using FieldPoint Explorer section of this chapter, and save your configuration file.

2. Select the BridgeVIEW » Export to BridgeVIEW option from the menu bar of FieldPoint Explorer to export the current configuration file that you just saved to BridgeVIEW’s active CCDB. (If BridgeVIEW is not an option on your FieldPoint Explorer’s menu bar, make sure that you have installed the FieldPoint software after installing BridgeVIEW.)

3. Exit FieldPoint Explorer.

4. Launch BridgeVIEW and load the Tag Configuration Editor by selecting Projects > Tag > Configuration from the menu bar of a BridgeVIEW window, or click on the Configure Tags button of BridgeVIEW’s initial tile screen.

5. Click on the Configuration Wizard button in the lower-right corner of the Tag Configuration Editor window, and then select FieldPoint from the list of servers that appears.

Note If you edit, rename, or move your configuration file after you export it to the BridgeVIEW Active CCDB, you must re-export the new configuration file. If you select another CCDB file as the Active CCDB for BridgeVIEW, you must re-export your FieldPoint configuration file to the newly selected Active CCDB file.

Note You must exit FieldPoint Explorer before you can use the FieldPoint server from BridgeVIEW.
All of the FieldPoint I/O Items in your configuration file are automatically imported as tags into BridgeVIEW and are now accessible through the BridgeVIEW real-time database. Do not worry if you get a message that no tags were created for the network modules in your system, as they do not have any I/O items.

6. You can edit the tags to change their names, scaling information, and other parameters.

Refer to your BridgeVIEW documentation for more information about tags and their configuration.

**Tip**  
The Tag Configuration Editor might be easier to read for FieldPoint tags if you change the middle column heading from **Tag Group** to **Item**.

7. When you have finished editing the tags (or if you chose to keep the default settings for the tags), exit the Tag Configuration Editor and save the changes to the configuration file.

You can now access the FieldPoint I/O Items by reading or writing these tags as you would any other tag in BridgeVIEW.

### Using the FieldPoint Lookout Driver Class

When you install the FieldPoint software, a FieldPoint driver class is created if Lookout has already been installed on your computer. When you create a FieldPoint object within Lookout, you specify the configuration file created by FieldPoint Explorer. The FieldPoint object you create uses this configuration file to import the information about the I/O items that you had configured within FieldPoint Explorer. All of these I/O Items are immediately accessible as writable and/or readable data members.

To start using the FieldPoint Lookout driver class, follow these steps:

1. Configure and test your FieldPoint server from FieldPoint Explorer, as described in the *Using FieldPoint Explorer* section of this chapter, and save your configuration file.

2. Exit FieldPoint Explorer.

**Note**  
You must exit FieldPoint Explorer before you can use the FieldPoint driver class from Lookout.
3. Start Lookout, and create a new control panel or open an existing one.

4. Select **Object ➤ Create** from the menu bar and choose the FieldPoint object class from the **Drivers** category of the **Select Object Class** dialog box. The **Create FieldPoint Secondary** dialog box shown in Figure 4-6 appears.

![Create FieldPoint Secondary](image)

**Figure 4-6. Creating the FieldPoint Object**

5. Create your object.
   
a. Select the serial port you are using and the data rate (baud rate) in the **Communication Settings** area of the dialog box.
   
b. Enter the path of the configuration file you saved from FieldPoint Explorer in the **IAK Configuration File** area, and make sure the **Import alias information** box is checked. (You can use the **Browse** button to find the configuration file you saved.)
   
c. Make any changes you want to make to the poll rate or other parameters, and click on the **OK** button.

Your FieldPoint object is now created, and all of the I/O Items you configured in FieldPoint Explorer are available as data members of the object.
6. To verify that the data members were properly imported from your configuration file, or to modify the parameters of the data members, select **Objects** > **Edit Database** from the menu bar, and double-click on the FieldPoint object you just created. An object database window like the one in Figure 4-7 appears.

The **Configured Points** list should contain all of the I/O Items you configured in FieldPoint Explorer. The **Eng. units** in the scaling window indicate the configured range of analog I/O Items. From this window, you can modify the alias, alarm conditions, and other parameters of each data member in the FieldPoint object.

For more information about the FieldPoint driver object class and data members, refer to the National Instruments FieldPoint information in your Lookout documentation.

![Figure 4-7. Modifying the FieldPoint Data Members](image)
Using the FieldPoint LabVIEW VIs

When you install the FieldPoint software, a library of FieldPoint VIs is created if LabVIEW has already been installed on your computer. The FieldPoint VIs (FP Open, FP Get Configuration Info, FP Create Tag, FP Advise, FP Read, FP Write, and FP Close) directly access the I/O Items you configured in the FieldPoint Explorer program. In addition, a set of examples is placed in your LabVIEW Examples directory. These examples are the best way to get familiar with the LabVIEW VIs. The FieldPoint LabVIEW Help document is in the same program group on your Windows taskbar as the FieldPoint Explorer program. This help document explains how to use the FieldPoint VIs.

A simple FieldPoint application to read an I/O Item might only need to use four of the VIs. To create an example of such an application, complete the following steps and refer to Figures 4-8 and 4-9. This application reads the inputs from the I/O Item named All shown in Figure 4-1.

1. Use FP Open to open the server. By default, the server opens with the configuration file you last saved with FieldPoint Explorer.

2. Use FP Create Tag to create a handle to an I/O Item that you defined in FieldPoint Explorer. You provide three string names to this VI to indicate which I/O Item you want access to. These three strings are the names given to the communications resource, the device, and the I/O item. Figure 4-7 shows default names as they might appear when you use the Find Devices button in FieldPoint Explorer.

3. Use FP Advise to continuously monitor the I/O Item at the rate specified in FieldPoint Explorer. (You can also set a new rate with this VI.) In this example, the while loop executes at this advise rate. If you used FP Read VI here instead of FP Advise, the loop would free-run at the fastest rate it could sustain, reading the I/O Item over the serial port each time the loop ran.

Note Do not put more than one FP Advise VI in a loop. All VIs in a loop execute only once each time a loop runs, and FP Advise VIs only complete at their advise rate. If you had more than one FP Advise VI in the loop, the loop (and therefore all of the FP Advise VIs in the loop) would only execute at the slowest rate of the Advises. The loop might not execute at all if any of the Advises is set to complete “On Data Change,” and the data of the corresponding I/O Item never changed.
4. Use FP Close to close the server. This action also stops all pending Advise operations.

Note This example reads the value of an I/O Item value from the FieldPoint device. To write to an Output Item, use FP Write instead of FP Advise (or FP Read).

Figure 4-8. LabVIEW Diagram for LabVIEW Example Application

Figure 4-9. Front Panel for LabVIEW Example Application
Using the FieldPoint LabWindows/CVI Functions

When you install the FieldPoint software, a LabWindows/CVI instrument driver for FieldPoint is created if LabWindows/CVI has already been installed on your computer. This instrument driver includes function panels to call C functions that directly access the I/O Items you configured in the FieldPoint Explorer program. In addition, a set of sample projects is placed in your LabWindows/CVI Samples directory. These examples are the best way to get familiar with these functions. The FieldPoint CVI Help document is in the same program group on your Windows taskbar as the FieldPoint Explorer program. This help document describes each function in the instrument driver with a description of the C syntax, a description of each parameter, and a list of possible error codes.

Note FieldPoint CVI Interface Compatibility Modes: The FieldPoint software ships with object (.obj) files to support the different compiler compatibility modes that LabWindows/CVI supports (Microsoft Visual C/C++, Borland, Watcom, and Symantec). When FieldPoint software is installed, the Microsoft compatibility mode is installed by default. To use an alternate compatibility, copy the supplied .obj file from the compiler folder (for instance, /CVI/FieldPoint/borland/FieldPoint.obj) with which you would like compatibility to the /FieldPoint subdirectory of the CVI directory.

Using the FieldPoint OPC Server

OPC (OLE for Process Control) is an industry standard device interface specification that provides interoperability between field devices such as FieldPoint and application software packages. The FieldPoint OPC server, like the other FieldPoint interfaces, imports the I/O Items that you configured in FieldPoint Explorer and makes them available as OPC Items to an OPC client, a software program designed to communicate with OPC servers. The FieldPoint OPC server allows any application written as an OPC client to access the FieldPoint hardware over the serial port. Because OPC is based in part on Microsoft’s DCOM (Distributed Component Object Model), it is even possible for an OPC client on one computer to access FieldPoint hardware connected to the serial port of another computer if the two computers are networked together.

OPC clients might differ in the features they offer and their presentation of the OPC interface for the FieldPoint OPC server. Refer to the documentation on using the OPC client features of your application for detailed instructions on how to access an OPC server. However, the basics steps involved are similar for most OPC client applications.
Follow these steps to start using the FieldPoint OPC server:

1. Open the FieldPoint OPC server,
   National Instruments.OPCFieldPoint.
   This server was registered with Windows when you installed the FieldPoint software. OPC Clients should be able to show you a list of available registered servers, but you might have to type this name in yourself. The OPC client might automatically connect to the server when you select it, but if you are given the option to explicitly connect to the FieldPoint OPC server, you should do so.

2. Create a group.
   Groups are a collection of I/O items. Some OPC clients might not give you the option of creating groups, or they might be created for you.

3. Select the I/O Items, which you configured in FieldPoint Explorer, that you want to read or write as a part of this group.
   Many OPC clients can use the “Browse Address Space” feature of the FieldPoint OPC Server to show you a list of all of the I/O Items you configured in FieldPoint Explorer. However, if the OPC client you are using does not support this feature, you might need to type the Item IDs of the I/O Items directly. The naming convention of the FieldPoint Item IDs is [Comm resource name][Device Name][I/O Item name] where the Comm resource, Device, and I/O Item names are the names given in FieldPoint Explorer. For example, an Item ID associated with one of the I/O Items shown in Figure 4-1 would be FP Res\FP-TC-120 @1\Channel 0.

In most cases, the preceding steps are all that is required to configure an OPC client to read from I/O items of the FieldPoint OPC server. In some cases, the OPC client might require more information about the FieldPoint OPC server. The following list contains additional information about the FieldPoint OPC server, which you might find helpful.

- The FieldPoint OPC Server does not require an Access Path. Some OPC clients might expect the access path to be included in the Item ID name or might request the access path when you select I/O Items. You should be able to leave the access path blank (empty string).
- The FieldPoint OPC custom interface is an out of process server.
- The FieldPoint OPC Server supports both synchronous and asynchronous reads and writes.
- The FieldPoint OPC Server uses the “GetErrorString” method to return error and diagnostic messages from the FieldPoint server and hardware. OPC clients that do not support this method might only give you error messages like “Bad, non-specific” along with an error code.
Some OPC clients that do not support this “GetErrorString” method might still provide a way for you to manually look up the FieldPoint message corresponding to the error code using the method.

**Using FieldPoint with an Optomux Server**

The FP-1000/1001 supports many of the commands of the standard Optomux protocol, so it is possible to communicate with the FieldPoint hardware using an Optomux server. This might be appropriate for an application where you are integrating FieldPoint into a system that is already using an Optomux server, or if you are using FieldPoint with an operating system not compatible with the other software options provided with your FieldPoint software. (The FieldPoint software does not include a generic Optomux server.) The *FP-1000/1001 Programmer Reference Manual* has detailed information on the protocol used by the FP-1000/1001, including which standard Optomux commands are supported and which are not. It is also a reference for working with the ASCII protocol directly. However, a general overview of using FieldPoint with Optomux servers is provided here as a guide.

- Standard Optomux commands do not allow for the configuration of hardware settings, so you must use FieldPoint Explorer to set your hardware settings (such as are set in Step 7 in the *Getting Started with FieldPoint Explorer* section, earlier in this chapter). If you make these settings the default power-up settings for the hardware (as described in Step 10 of that section), the FP-1000/1001 network module always powers up the I/O modules to these settings, so you do not need to run the FieldPoint Explorer more than once to configure your network module.

- The Optomux address of the FP-1000/1001 network module is the network address set by the switches as described in Table 2-1, *Network Address Switch Settings for the FP-1000/1001*, in Chapter 2, *Hardware Installation and Configuration*. The Optomux address of the I/O module in the first terminal base attached to the network module is one plus the address of the network module, and so on. In most cases you do not need to communicate with the network module, expect perhaps to change watchdog timer settings.

- Optomux analog data contains only 12 bits of resolution and is usually represented as an integer from 0 to 4095. Data that is returned from a FieldPoint analog channel has its minimum value represented by 0 and its maximum value represented by 4095. In some cases Optomux data
might be represented by integers from 4096 (representing the minimum value of an analog channel) to 8191 (representing the maximum value of an analog channel).

- The standard Optomux protocol is not capable of returning the full range of error and diagnostic features supported by FieldPoint modules.

- If you are writing your own server, sending and receiving messages directly using the serial port, you are highly encouraged to use the extended FieldPoint command set as described in the *FP-1000/1001 Programmer Reference Manual* to get the most out of your FieldPoint hardware. Examples of programs that directly access the serial port to communicate with the FieldPoint network modules are available on the National Instruments FTP site at ftp.natinst.com/support/fieldpoint/Examples/.
Specifications

This appendix describes the specifications of the FP-1000 and FP-1001 network modules.

All FieldPoint network modules undergo extensive testing for operating under rugged environmental conditions that exist in industrial applications. FieldPoint network modules are designed and tested for immunity and susceptibility, as well as for emissions.

Network

FP-1000.................................................. 1 RS-232 port, 1 RS-485 repeater port
FP-1001.................................................. 1 RS-485 port
Baud rates............................................... 300, 1200, 2400, 9600, 19200, 38400, 57600, 115200 (switch-settable)
Communication parameters ............... 1 start bit, 8 data bits, 1 stop bit, no parity
Integrity .................................................. Checksum
Cabling distance from host*  
FP-1000............................................... 50 ft (nominal)*  
FP-1001............................................... 4000 ft (nominal)*  
* Refer to the RS-232 Interface Specifications and RS-485 Interface Specifications sections in Chapter 2, Hardware Installation and Configuration.

Power supply range.......................... 11 to 30 VDC
Power consumption.......................... 1 watt + 1.15 × ∑(I/O Module Consumption)
Maximum terminal bases per bank ....... 9
Maximum number of banks.................25
RS-232/RS-485 interface chips ..........15 kV ESD, low noise and slew rate, limited interface ICs
RS-485 isolation ................................2500 Vrms breakdown,
                                           250 Vrms operational

Environment
Operating temperature ..................−40 to +70 °C
Storage temperature .......................−55 to +90 °C
Relative humidity ...........................5% to 90% noncondensing

Compliance
Electrical safety ..........................designed to meet IEC 1010
EMI emissions/immunity .................CISPR 11
Visit the following sections of the National Instruments Web site at ni.com for technical support and professional services:

- **Support**—Online technical support resources include the following:
  - **Self-Help Resources**—For immediate answers and solutions, visit our extensive library of technical support resources available in English, Japanese, and Spanish at ni.com/support. These resources are available for most products at no cost to registered users and include software drivers and updates, a KnowledgeBase, product manuals, step-by-step troubleshooting wizards, conformity documentation, example code, tutorials and application notes, instrument drivers, discussion forums, a measurement glossary, and so on.
  - **Assisted Support Options**—Contact NI engineers and other measurement and automation professionals by visiting ni.com/support. Our online system helps you define your question and connects you to the experts by phone, discussion forum, or email.

- **Training**—Visit ni.com/custed for self-paced tutorials, videos, and interactive CDs. You can also register for instructor-led, hands-on courses at locations around the world.

- **System Integration**—If you have time constraints, limited in-house technical resources, or other project challenges, NI Alliance Program members can help. To learn more, call your local NI office or visit ni.com/alliance.

- **Declaration of Conformity (DoC)**—A DoC is our claim of compliance with the Council of the European Communities using the manufacturer’s declaration of conformity. This system affords the user protection for electronic compatibility (EMC) and product safety. You can obtain the DoC for your product by visiting ni.com/hardref.nsf.
• **Calibration Certificate**—If your product supports calibration, you can obtain the calibration certificate for your product at ni.com/calibration.

If you searched ni.com and could not find the answers you need, contact your local office or NI corporate headquarters. Phone numbers for our worldwide offices are listed at the front of this manual. You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.
Glossary

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Prefix</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>milli</td>
<td>$10^{-3}$</td>
</tr>
<tr>
<td>k</td>
<td>kilo</td>
<td>$10^3$</td>
</tr>
<tr>
<td>M</td>
<td>mega</td>
<td>$10^6$</td>
</tr>
</tbody>
</table>

% percent
° degrees
Ω ohms
b bits
B bytes
bank The combination of one FieldPoint network module and one or more terminal bases and I/O modules.
bps bits per second
C celsius
CISPR International Special Committee On Radio Interference
DSR Data Set Ready
EDS electronic data sheet
EMI electromagnetic interference
ESD electrostatic discharge
ft feet
FTP file transfer protocol
HotPnP Hot Plug and Play
IEC International Electrotechnical Commission
in. inches
I/O input/output
LED Light-emitting diode
### Glossary

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC</td>
<td>OLE for Process Control</td>
</tr>
<tr>
<td>POST</td>
<td>power-on self test</td>
</tr>
<tr>
<td>RTS</td>
<td>Request to Send</td>
</tr>
<tr>
<td>V</td>
<td>Volts</td>
</tr>
<tr>
<td>VDC</td>
<td>Volts direct current</td>
</tr>
<tr>
<td>Vrms</td>
<td>Volts root mean squared</td>
</tr>
</tbody>
</table>
Index

A
ACCESS LED, 2-16, 3-7
addresses, setting
   network address, 2-12 to 2-14
   switches (table), 2-14
   unique address for each module (note), 2-13

B
banks. See FieldPoint banks.
baud rate
   address and baud rate switch location
      (figure), 2-12
   switch settings (table), 2-15
biasing resistors for RS-485 port, 2-10
BridgeVIEW server, 4-2, 4-12
bus, high-speed local, 3-1

cable lengths, 2-7, 2-9
calibration certificate, B-2
configuration of FieldPoint software, 4-1,
   4-4 to 4-11
configuration of network module
   address and baud rate selection,
      2-12 to 2-15
   baud rate settings, 2-15
   network address settings, 2-13
configuration, saving for FieldPoint bank,
   3-2 to 3-4
connections
   network
      FP-1000, 2-7
      FP-1001, 2-8
serial port, 2-7 to 2-11
   isolation of RS-485 interface
      (caution), 2-9
   RS-232 interface specifications, 2-7
   RS-485 interface specifications, 2-9
terminal base
   with DIN rail mounting, 2-3
   with panel mounting, 2-5
connector pinouts
   power connector (figure), 2-16
   RS-232 ports (figure), 2-8
   RS-485 ports (figure), 2-10
contacting National Instruments, B-2
customer
   education, B-1
   professional services, B-1
   technical support, B-1

C
cable lengths, 2-7, 2-9
calibration certificate, B-2
configuration of FieldPoint software, 4-1,
   4-4 to 4-11
configuration of network module
   address and baud rate selection,
      2-12 to 2-15
   baud rate settings, 2-15
   network address settings, 2-13
configuration, saving for FieldPoint bank,
   3-2 to 3-4
connections
   network
      FP-1000, 2-7
      FP-1001, 2-8

D
Declaration of Conformity, B-1
diagnostic resources, B-1
DIN rail
   connecting terminal bases on, 2-3
   mounting network module on, 2-1
   rail clip, 2-1, 2-2
   removing network module from, 2-3
distances, cabling, 2-7, 2-9
documentation
   conventions, ix
   how to use manual set, ix
   online library, B-1
drivers
   instrument, B-1
   software, B-1
Index

E
environmental specifications, A-2
error conditions indicated by STATUS LED (table), 3-8
table, 3-8
example code, B-1
Explorer, FieldPoint, 4-1, 4-4 to 4-11

F
feature set description, 3-1 to 3-8
high-speed local bus, 3-1
HotPnP (Hot Plug and Play), 3-4
LED indicators, 3-7
network watchdog timer, 3-1
power-on self test (POST), 3-6
Programmable Power-up State, 3-3
SnapShot feature, 3-2
FieldPoint banks
calculating power for bank, 2-16
maximum number of banks, 1-2
network watchdog timer, 3-1
SnapShot feature, 3-2
FieldPoint network modules. See also feature set description.
overview, 1-1 to 1-2
specifications, A-1
FieldPoint software, 4-1 to 4-21
BridgeVIEW server, 4-2, 4-12
configuring, 4-1 to 4-2, 4-4 to 4-11
FieldPoint Explorer, 4-1 to 4-2, 4-4 to 4-11
installing, 4-4
LabVIEW VIs, 4-2, 4-16
LabWindows/CVI functions, 4-2, 4-18
Lookout driver class, 4-2, 4-13
OPC server, 4-3, 4-18
Optomux server, 4-3, 4-20
overview, 4-1 to 4-3
FP-1000
configuring, 2-12 to 2-15
connecting to computer, 2-7
connection to RS-232 port, 1-2
FP-1001
configuring, 2-12 to 2-15
connection to network, 2-8
connection to RS-485 port, 1-2

H
help
professional services, B-1
technical support, B-1
HotPnP (Hot Plug and Play), 3-4
during operation, 3-4
during power-up, 3-4
inserting new I/O modules, 3-4
module configuration results after HotPnP replacement (table), 3-6
overview, 3-4
replacing I/O modules, 3-5

I
I/O modules
inserting new, 3-4
installing onto terminal bases, 2-6
module configuration results after HotPnP replacement (table), 3-6
replacing, 3-5
saving power-up configuration, 3-2 to 3-4
installation, 2-1 to 2-16
connecting to computer
FP-1000, 2-7
FP-1001, 2-8
HotPnP (Hot Plug and Play) features, 3-4
mounting
on DIN rail, 2-1
on panel, 2-4
power connections, 2-15 to 2-16
removing network module
  from DIN rail, 2-3
  from panel, 2-6
serial port connections, 2-7 to 2-11
  isolation of RS-485 interface
    (caution), 2-9
  RS-232 interface specifications, 2-7
  RS-485 interface specifications, 2-9
terminal base connection
  with DIN rail mounting, 2-3
  with panel mounting, 2-5
instrument drivers, B-1
isolation, 2-9

K
KnowledgeBase, B-1

L
LabVIEW VIs, FieldPoint, 4-2, 4-16
LabWindows/CVI functions, FieldPoint, 4-2, 4-18
LED indicators, 3-7
local bus, high-speed, 3-1
Lookout driver class, FieldPoint, 4-2, 4-13

M
mounting. See installation.

N
National Instruments
  calibration certificate, B-2
  customer education, B-1
  Declaration of Conformity, B-1
  professional services, B-1
  system integration services, B-1
  technical support, B-1
  worldwide offices, B-2
network address, setting, 2-13
NETWORK LED, 3-7
network module. See FieldPoint network modules.
network termination and biasing, RS-485 ports, 2-10
network watchdog timer, 3-1
online technical support, B-1
OPC server, FieldPoint, 4-3, 4-18
Optomux protocol, 1-2
Optomux server, FieldPoint, 4-20
panel mounting
  connecting terminal bases on, 2-5
  mounting network module on, 2-4
  removing network module and terminal bases from, 2-6
phone technical support, B-2
pinouts. See connector pinouts.
power connections, 2-15
  calculating power for FieldPoint bank, 2-16
  pinout (figure), 2-16
POWER LED, 2-16, 3-7
power-on self test, 3-6
Programmable Power-up State, 3-3
programming examples, B-1
rail clip, locking (figure), 2-1
removing FieldPoint network module
  from DIN rail, 2-3
  from panel, 2-6
removing terminal bases from panel, 2-6
Index

RS-232 ports
  connector pinout (figure), 2-8
  FP-1000 connection to, 1-2, 2-7
  interface specifications, 2-7
RS-485 ports
  connector pinout (figure), 2-10
  FP-1001 connection to, 1-2, 2-8 to 2-10
  interface specifications, 2-9
  isolation from FieldPoint systems
    (caution), 2-9
  network termination and biasing, 2-10
  typical signal connections (figures), 2-11

S
  safety isolation, 2-9
  serial ports. See RS-232 ports; RS-485 ports
  SnapShot feature, 3-2
  software drivers, B-1
  software. See FieldPoint software.
  specifications, A-1
    compliance, A-2
    environment, A-2
    network, A-1
  STATUS LED, 2-16, 3-8
  support
    technical, B-1
  switches
    address and baud rate (figure), 2-12
    baud rate settings (table), 2-15
    network address settings (table), 2-14
  system integration services, B-1

T
  technical support, B-1
  telephone technical support, B-2
  terminal base connection
    with DIN rail mounting, 2-3
    with panel mounting, 2-5
  termination and biasing, RS-485 ports, 2-10
  throughput, 4-3
  training
    customer, B-1
  troubleshooting resources, B-1

U
  update rate. See throughput.

W
  watchdog timer, 3-1
  Web
    professional services, B-1
    technical support, B-1
  worldwide technical support, B-2